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ABSTRACT 

The concept of a fan-wing aircraft configuration for the purpose of vertical 

takeoff and landing has drawn much attention. Recently, more investigations revealed 

that a cross-flow fan (CFF) was capable of providing the propulsion. Several 

characteristics of the off-design performance of a CFF were experimentally measured, 

but insufficient numerical predictions were obtained.  

In the present study, the commercial CFD software ANSYS CFX was employed 

to calculate the unsteady flow through a CFF with a sliding mesh incorporated. The 

results of the CFD showed the necessity to re-investigate the cross-flow fan with 12-inch 

diameter, 1.5-inch span and 30 blades, and additional measurement locations were 

implemented to carry out a more accurate experiment. A new digital sensor array was 

used to record the pressures within the experiment, which contributed to the high fidelity 

of the present data. Successful comparisons were made between the predicted and 

measured performance at various rotational speeds from an open throttle position to a 

setting at stall. Visualization of the computed flow field showed where stall occurred, 

both within the rotor and in the exhaust duct.  
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I. INTRODUCTION  

Vertical and short takeoff and landing (V/STOL) vehicles have been studied for 

many years. Requirements for larger thrust and higher fuel efficiency were encountered. 

In order to meet those requirements, a device, the Cross-Flow Fan (CFF), was first 

introduced in 1975 by the Vought Systems Division (VSD) [Ref. 1] of LTV Aerospace 

Corporation. Several tests were performed on various fan and housing configurations. 

Also, the location of shocks and vortices within the device were investigated. The 

capabilities of this device to be used as a propulsion system were recommended. 

However, more experiments needed to be carried out to provide more understanding of 

the off-design performance of the cross-flow fan. 

Based on the experimental data by VSD, Dean H. Gossett [Ref. 2] designed a 

light-weight VTOL aircraft to be used for transportation between cities. Fan number 6 

with an exit duct height of 4.6-inch was selected due to its higher thrust production. 

Theoretically, his concept of a wing-and-canard type air vehicle sparked the possibilities 

of utilizing a cross-flow fan as the sole propulsive device for the aircraft.  

The performance of a cross-flow fan was tested in the Turbopropulsion 

Laboratory of the Naval Postgraduate School by M. Scot Seaton [Ref. 3]; and a numerical 

model, using FLO++, was also initiated to predict the performance for further design 

purposes. Moreover the concept of the Fan-Wing aircraft was not only proposed but also 

treated numerically in a conceptual wing configuration. This work was continued by Wee 

Teck Cheng [Ref. 4] who measured the off-design performance of the 12-inch CFF up to 

6000RPM. He also predicted the design performance of the CFF at 3000RPM using 

FLO++, however, his off-design prediction did not follow the experimental trends. 

Using the experimental results from [Ref. 4] , a cross-flow fan embedded into an 

airfoil was proposed and designed by Joseph D. Kummer [Ref. 5]; an incredible 

enhancement of airfoil lift coefficient under specific conditions was predicted by 

employing the software package, FLUENT. Practically, it would be a problem to couple 

this device into an aircraft. It was revealed that the utilization of a cross-flow fan to 

achieve high lift propulsion should be given more attention.  
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Since the concept of a Fan-Wing aircraft with a cross-flow fan was regarded as a 

possible application, a smaller sized cross-flow fan was needed and its performance 

needed to be investigated. More recently, a 6-inch CFF was tested both with a 1-1/2-inch 

span and a 6-inch span rotor at low to moderate speeds [Ref. 6]. Since the simulation by 

FLO++ only provided results for incompressible flow, the software package, ANSYS 

CFX, was used in the present study. The code could more accurately model compressible 

flow and could also model rotating machinery. Discrepancies found in the measurement 

of mass flow rate in the previous data, necessitated repeating the test of the 12-inch rotor 

with a new pressure measuring digital sensor array. The off-design performance 

prediction using CFX-5 more closely followed the experimental results obtained in the 

present study.  



II. EXPERIMENTAL SETUP  

A. DESCRIPTION OF THE EXPERIMENTAL APPARATUS 

1. Test Rig 
The fan was tested in the Turbine Test Rig (TTR) at the Turboproplusion 

Laboratory of the Naval Postgraduate School. The TTR was powered by compressed air 

from an Allis-Chalmers compressor, which was driven by a 1,250 horsepower motor. The 

compressor could produce 10,000 cubic feet per minute of air at a maximum pressure of 

30 psig. A schematic of TTR is shown in Figure 1.  

 
Figure 1.   Schematic of the Turbine Test Rig (from Ref 5) 

 
2. Cross-Flow Fan Test Assembly (CFFTA) 
The Cross-Flow Fan Test Assembly (CFFTA) design was derived from the VSD 

Multi-Bypass Ratio System test assembly #6 [Ref. 1]. A schematic of it is shown in 

Figure 2. The configuration of the CFFTA was composed of a fan rotor (with 30 blades, 

12-inch diameter and 1.5 inch span), two cavity components, an exhaust duct wall, a 

drive shaft, and bearing housing.  

For the initial tests, unlike [Ref. 3] and [Ref. 4], an inlet bell-mouth was used to 

measure the mass flow rate, which was denoted Test Plan I. For the second test, an 

extended exhaust duct and butterfly throttle valve, were added in order to measure the 

performance at various mass-flow rates. This was denoted as Test Plan II. 
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(a) Schematic 

 
(b) Fan Rotor 
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(c) Partially Assembled 

Figure 2.   Cross-Flow Test Assembly (CFFTA, from Ref. 5) 
 

3. Control Station 
The CFFTA was controlled by adjusting a bypass dump valve, and an inlet valve 

to the TTR. Atmospheric pressure, rotational speed of the fan, bearing temperatures and 

vibrations were monitored, and were recorded in a logbook during the test, once a desired 

rotational speed and throttle setting was stably achieved  

4. Data Acquisition and Instrumentation 
Instruments employed to measure the flow properties were United Sensor Devices 

model USD-C-161 3 mm (1/8-inch) combination thermocouple/pressure probes, and 

static pressure taps. The locations of the probes, which are shown in the schematic in 

Figure 3, were slightly different from [Ref 3] and [Ref 4]. Two more probes were added 

in the exhaust duct, and one was placed in the inlet section at the 12 o'clock position. The 

type of measurement and labels of probes are listed in Table 1 and Table 2.  

It was concluded that the variation of total pressure of the three inlet combination 

probes was not significant; therefore, they were averaged by introducing "tees" to 

combine them before being connected to the pressure transducer array. In the same 

manner, this averaging technique was applied to the three static pressure tapes at the 

throat of the bell-mouth and to the two exhaust duct static pressure taps.  

Once the data were acquired, the pressures were converted from analog signals 

through the digital sensor array (DSA) into digital signals which were acquired by the 

5 



computer via an internet cable. Temperatures were recorded by a Hewlett- Packard HP 

E1326B Multimeter Adapter, which was connected to computer via the VXI mainframe.  

 
Figure 3.   Combination probes and pressure tap layout 

 

Multiplexer 
Channel Probe Nomenclature 

4 A AouttT ,,  

13 B BouttT ,,  

14 C CouttT ,,  

15 D DouttT ,,  

5 E EouttT ,,  

6 F FintT ,,  

8 G GintT ,,  

9 H HintT ,,  

10  TTRintT ,,  

11  TTRouttT ,,  

12  orificeintT ,,  
Table 1.   Thermocouple scanning multiplexer channel assignments 
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Port # Probe Nomenclature Type 
4 A AouttP ,,  Total Pressure 
5 B BouttP ,,  Total Pressure 
6 C CouttP ,,  Total Pressure 
7 D DouttP ,,  Total Pressure 
8 E EouttP ,,  Total Pressure 

F 
G 3 
H 

intP ,  Total Pressure 

2  nozzleP  Static Pressure 

1  outP  (for Test Plan II 
only) 

Static Pressure 

Table 2.   Scanivalve port assignments 
 
B. DATA ACQUISITION AND REDUCTION 

The software Agilent VEE, which is a window-based data acquisition program, 

was used to develop a new graphical use interface (GUI), called CFF_DAQ, to acquire all 

temperatures, pressures and the rotational speed of the CFF. This is shown in Figure 4. 

All data were written to a text file, which EXCEL could read, and then data reduction 

procedures were performed to calculate parameters of interest. The program structure of 

CFF_DAQ is given in APPENDIX A.  

 
Figure 4.   CFF_DAQ graphical user interface 



During the post processing, several properties had to be related since mass-flow 

rate, total pressure ratio, total temperature ratio, efficiency, thrust, and power had to be 

calculated. Data reduction included referring to standard day conditions (  

and ).  

KT stdt 15.288, =

PaP stdt 325,101, =

The mass flow rate was obtained from the bell-mouth measurements, and the 

basic equations used for the calculation are presented below. For a detailed derivation, 

please refer to APPENDIX B. 

inin AV
RT
Pm

1

1=    (1) 

( ) 2
11 2

1
int V
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TT

γ
γ −
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⎝

⎛
−
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2

1

1

1

1

1

P
P

P
P

RT
V t

t

t
in γ

γ

   (3) 

where ; nozzlePP =1 A  is the cross-area of the bell-mouth; atmt PP =1 , which was read from 

the control station; , which was an average of ,  and . (See 

Figure 3) 

intt TT ,1 = FintT ,, GintT ,, HintT ,,

Since there were five probes placed in the outlet section, as shown in Figure 5, 

five zones (from A to E) were utilized to calculate mass-averaged outlet properties of 

total pressure and temperature. The expressions of compressible flow were introduced 

from [Ref. 7] and used to evaluate the mass flow rate within each zone; 

( ) iitp
it

it
iii ATc

RT
P

XXm ,
,

,1
1

2 21 −−= γ    (4) 

where  was defined as a fraction equal to the velocity referred to the stagnation 

velocity. This was calculated from the following relationship between local static and 

stagnation pressures;  

X
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γ
γ 1

,

1

−

⎟
⎟
⎠

⎞
⎜
⎜
⎝

⎛
−=

it
i P

PX    (5) 

where 

atmPP =  (for Test Plan I), outtPP ,=  (for Test Plan II),  

and i  indicates each zone. ; KsmR ⋅= 22 /287 KkgJc p ⋅= /4.1004 ; 402.1=γ ;  and 

 were measured from the five combination probes;  was the area of each zone and 

the values provided in Table 3 were measured according to the actual locations of the 

probes. 

itP ,

itT , iA

 
Figure 5.   Schematic of the position of the combination probes in the exhaust duct  

 

Zone Area [ ] 2m

A 0.000919353 

B 0.000774192 

C 0.001016127 

D 0.00096774 

E 0.000677418 

Table 3.   Area values of each zone 

Thus, the mass averaged total pressure and temperature in the exhaust duct were obtained 

from; 
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The total pressure ratio (π ), total temperature ratio (τ ) and efficiency (η ) were then 

found by; 

int

outt

P
P

,

,=π    (8) 

int

outt

T
T

,

,=τ    (9) 

1
1
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−
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−

τ
πη
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   (10) 

Next, the thrust force was obtained from;  

( )inoutinthrust uumF −=    (11) 

where  was assumed to be zero and;  inu

outoutout RTMu γ=    (12) 
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Finally, the power absorbed by the CFF was calculated from; 

( )intouttpinower TTcmP ,, −=    (15) 
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After all the parameters were calculated, the correction to standard day conditions 

was accomplished as follows;  

stdt

int

P
P

,

,=δ ; 
stdt

int

T
T

,

,=θ    (16) 

δ
θmmcorr = ; 

θ
NNcorr = ; 

δ
FFcorr = ; 

θδ
PPcorr =    (17) 

C. TEST PLANS 
Two test plans were performed with both cavities opened; these were, Test Plan I 

- the Baseline Configuration, which was run from 1000RPM up to 5000RPM, and Test 

Plan II - the Throttling Investigation, where throttle settings were employed to control the 

mass flow rate at particular rotational speeds. The complete assemblies of both 

configurations are shown in Figure 6.  

 
(a) 
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(b) 

Figure 6.   CFFTA for (a) Test Plan I and (b) Test Plan II  
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III. DESCRIPTION OF THE NUMERICAL MODEL 

A. OVERVIEW  

In order to study characteristics of a flow in a cross-flow fan, the commercial 

computational fluid dynamics (CFD) package, CFX-5, which was developed by ANSYS 

Inc, was used to more accurately model the compressible flow through the CFF. Three 

modules were included; CFX-Pre, CFX-Solver and CFX-Post. In CFX-Pre, a simulation 

type was defined; rotating or stationary domain, boundary conditions and the interface 

surfaces were defined; initial values, solver controls and output controls were set. After 

initializing the information required by CFX-Pre, the simulation was started by writing 

files to the CFX-Solver. Convergence histories were monitored while running with the 

solver, which also wrote out result files (*.res and *.out). By using CFX-Post, the results 

could be read and plotted for visualization and further post processing.  

B. GEOMETRY AND GRID GENERATION  
The geometry for the 12 inch diameter rotor with 30 blades, based on the 

experiment by Seaton and Cheng [Ref 5 & 1], was created by using ICEM-CFD, which 

was compatible with CFX-5. Since a finite-volume approach was utilized in CFX-5, a 3-

dimensional geometry was required and generated with a span of 0.1 inch. It was then 

treated as a 2-D case, due to there being only one grid point in the span-wise direction.  

There were ten volume meshes generated separately throughout the geometry. 

Two were in the rotational domain, which were identified as BLADES and 

INNERCIRCLE,and eight parts were in the stationary domain, which were identified as 

INLET, OUTLET, High Pressure Cavity (HPC), Low Pressure Cavity (LPC), 

INLET(Interface), OUTLET(Interface), HPC(Interface) and LPC(Interface). Attention 

needed to be paid to the last four parts in the stationary domain, since they were adjacent 

to the rotational domain as shown in Figure 7. A complete volume mesh was created by 

merging each part together, which was done by opening individual mesh files (*.uns) 

sequentially. Therefore, 2D planes of each part sharing a common boundary between the 

interfaces were generated, which are shown in Figure 8. 



It was believed that the shape of the blades influenced the performance of the 

cross-flow fan. Thus O-grid topologies were employed for the regions around the blades 

in order to more accurately model the blade surface boundary layers, as shown in Figure 

9. Hexahedral cells were generated for all domains. A procedure for generating this 

geometry and mesh are provided in APPENDIX D. 

 
Figure 7.   Identification of the ten domains of the CFF mesh  
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Figure 8.   The planes between the interfaces  

 

 
Figure 9.   The meshes around blades 

 
 
C. METHODOLOGY AND BOUNDARY CONDITIONS  

Transient solutions were carried out by setting the interface between the rotational 

domains and the stationary domains within the model to “Transient Rotor-Stator”, and 

the sliding interfaces were then specified. The fluid was specified as an ideal gas with 
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constant specific heat at constant pressure. With a reference pressure of 1 atm, the 

opening inlet and opening outlet boundary conditions were set to an average relative total 

pressure of 0 atm, and a relative static pressure of 0 atm, respectively. The reason for 

using an opening boundary condition, at both the inlet and exit, was because of 

uncertainty in flow recirculation at both boundaries. Static temperature of 300K, or 

standard day temperature, and turbulent intensity of 5% were also set for both inlet and 

outlet boundaries. An adiabatic smooth wall boundary with no slip was imposed, 

throughout on all walls.  

Total energy and the k-epsilon turbulence model were used to include effects of 

heat transfer and turbulence, respectively. By setting a transient initialisation, the 

simulation could be run without initial values interpolated; the solver default values were 

employed at the beginning of the run. Equations involved in the solver were continuity, 

momentum, energy, turbulence eddy dissipation, turbulence kinetic energy, and an 

equation of state. The set-up procedure in CFX-Pre is also provided in APPENDIX E. 

Continuity equation:  
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Momentum equation:  
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D. SIMULATION PLANS 

Two simulation plans were embarked on to predict the performance at conditions 

similar to the experimental test plans. These are summarized in Table 4. The 

configurations of both plans are presented in Figure 10. As shown, to constrain the inlet 

flow into the CFF, an extending wall was added instead of the bell-mouth, the mass-flow 

rate was, therefore, recorded from the inlet boundary for the following analysis. More 

difficulties were encountered to predict the case of Test Plan II, a suitable diffuser had to 

be determined to carry out the expected mass flow rate variation since several effects had 

to be considered, such as inlet turbulence and inlet velocity profile.. From [Ref. 8], the 

maximum diffuser  and  was used. To vary the mass flow rate, the 

diffuser was closed gradually by 1.75 degree until stall occurred.  

2/ 1 =WL 0142 =θ

Case 

Speed 

Simulation Plan I 

(corresponding to Test Plan I) 

Simulation Plan II 

(corresponding to Test Plan II) 

1000RPM V  

2000RPM V V 

3000RPM V V 

4000RPM V  

5000RPM V V 

Table 4.   Summary of simulation plans 
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(a) 

 
(b) 

Figure 10.   Geometric profile of (a) Simulation Plan I and (b) Simulation Plan II  
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IV. RESULTS AND DISCUSSION 

A. MESH SENSITIVITY STUDY 

The mesh sensitivity was studied under a rotational speed of 3000RPM with a 

time-step of 3.33333e-5 seconds, which corresponded to a rotation angle of 0.6 degrees 

per time step.  

At first, with a constant number of mesh elements (62,493), the sensitivity was 

studied by varying the spacing of grids of specific parts, and run for 10 revolutions. Since 

meshes were not distributed uniformly along the interfaces, the confirmation of 

transferring properties between domains was required. It was required that the differences 

between simulated results were less than 0.06%. The best results were obtained with the 

most clustering of points close to the interfaces. Two more different mesh sizes were 

modeled, the coarse one with 13,657 elements and the finest one with 250,573 elements. 

Once the calculations were completed, the efficiency was used as an indicator to 

determine the optimum mesh size. It was found that the coarse mesh size provided an 

efficiency of 57.26%, and the finest one provided an efficiency of 76.16%, those were not 

close to the expected efficiency of 68%. The only explanation for this was that the errors 

accumulated in the finest meshes, which adversely effected in the transient model.  

However, a medium mesh size provided the efficiency of 68.13%, which 

corresponded favorably with the experimental value. In addition, its corresponding 

corrected mass flow rate of 0.4932 kg/s was calculated, which was close to the 

experimental value of 0.4872 kg/s. Therefore, the mesh size of 62,493 elements was used 

in the subsequent simulations. All the simulations were for 10 revolutions, the reason to 

be discussed in the following section on convergence history.  

 

B. TIME-STEP SELECTION 
Generally, smaller time-steps need more time to calculate but provide more 

accurate results. The goal of the present study was to find the optimal time-step, the one 

that would not only take less time for the simulation, but also provide an acceptable 

solution. Therefore, the selection of time-step was performed based on the consequence 



of the mesh sensitivity study with a rotating speed of 3000RPM. A computer with 

Pentium@ 4 CPU with double 3.2Ghz processors and 3.25 GB RAM was used. Four 

cases were carried out, which were 12 degrees, 6 degrees, 1 degree and 0.6 degrees 

rotational angle per time step, and all cases were run for only one revolution.  

It was found that all residuals (momentum and mass, turbulence, and heat transfer) 

were converged and fluctuated along , , and  for the first three cases, 

and computational times were 1 hours, 2 hours and 13 hours, respectively. For the last 

case, the residuals were just slightly lower than  but required 30 hours. Hence, 1 

degree angle per time step was selected for further simulations.  

310 − 43 10~10 −− 410 −

410 −

 

C. INITIAL SIMULATION RESULTS 
A baseline model at 3000RPM was first simulated for 10 revolutions to see if the 

converged solutions could be calculated. To compare with the results of experiments, the 

same locations of probes were used in the computational model. For each revolution, the 

parameters, such as mass-flow rate, total pressure ratio, total temperature ratio and 

efficiency, were calculated and monitored in order to check whether steady solutions 

were achieved.  

1. Convergence History  
The calculated parameters which were used for monitoring purposes were slightly 

different from those used for comparison to the experimental results. Since the expression 

of compressible flow (Eq. 5) may result in imaginary numbers, the mass flow rate in each 

zone within the exhaust duct was evaluated directly from the product of density and 

velocity read from probes in the model. The thrust was derived in the same manner.  

The convergence histories for the baseline test case at 3000RPM are shown in 

Figures 11-13. Figure 11 indicates that the simulation was started from no initalized flow 

field and it almost reached a stable value after 5 revolutions. This was also observed for 

the total pressure in Figure 12, however, the total temperature ratio still increased slightly, 

which affected the efficiency variation until the 8th revolution.  

The variation of efficiency for the last three revolutions in each model was about 

0.004, therefore the solution at the 10th revolution was considered to be stable. All 
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subsequent calculations were therefore carried out until 10 revolutions had been 

completed. The convergence histories of all subsequent models were monitored in the 

same manner.  

 
Figure 11.   Convergence history of mass flow rate at 3000RPM 

 
Figure 12.   Convergency history of total pressure ratio and total temperature ratio at 

3000RPM 
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Figure 13.   Convergency history of efficiency at 3000RPM 

 

2. Flow Visualization 

Figure 14 shows vector distributions of flow velocity for both cavities. In the high 

pressure cavity (HPC), the direction of flow was clockwise, but counterclockwise in 

thelow pressure cavity (LPC), which agreed with the observation in [Ref. 4]. Additional 

vortical flow features occurred between the blades. The highest velocity region was 

found within the LPC, consistent with the low pressure. Similarly, the lowest velocity 

region was found within the HPC, consistent with the high pressure, which explained the 

names of these cavities.  

Figure 15 shows that the lowest pressure did not occur within the LPC, but rather 

within the rotor close to the LPC. The total pressure profile at the outlet boundary 

suggested more measuring probes should be used to provide more accurate experimental 

results.  

Figure 16 indicates that the most energy lost was due to the vortex that occurred 

around the LPC. More heat was generated within this region, which caused the 

temperature at the LPC to be higher than at the HPC. The exit plane total temperature 

distribution was non-uniform, with the highest temperature close to the top wall; however 

the variation of temperature was less than 10 degrees.,  
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Figure 17 shows the distribution of Mach number, which supports the assumption 

of subsonic flow within the CFF at 3,000 RPM. A large recirculation in the HPC was 

observed. The highest Mach numbers (~0.39) occurred at three locations, one was within 

the blades near to the LPC; a second one was in the LPC, and the third one was near to 

where the flow entered the exhaust duct. The velocity profile at the exhaust duct exit 

plane is also shown. It was observed that the flow entrainment into the CFF was roughly 

at the one o'clock position into the rotor..  

 
Figure 14.   Vector plot of velocity in HPC and LPC at 3000RPM 
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(a) Whole flow field 
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(b) Exit plane 

Figure 15.   Distribution of total gauge pressure at 3000RPM  
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(b) Exit plane 

Figure 16.   Distribution of total temperature at 3000RPM  
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(b) Exit plane 

Figure 17.   Distribution of Mach number at 3000RPM  

 

D. EXPERIMENTAL DATA CONSISTENCY STUDY 
The derived parameters from [Ref. 4] were converted from English Engineering 

(EE) to SI units, and the raw data sets were re-calculated by the procedure mentioned in 
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Chapter II, section B. Those two data sets were compared to make sure no inconsistencies 

occurred during the calculations. Since two test plans, with two cavities opened, were 

tested in this study, only those cases in [Ref. 4] were considered in the following. The 

results are shown in Figures 18-25. 

1. Test Plan I 
It was expected that the curves re-calculated here [shown as Re-cal] would 

overlap the existing curves [Ref. 4], in Figures 18-21, since the same procedures were 

applied. However, it was found that at high rotatiional speeds, the differences increased, 

especially in the mass flow rate. However, the differences in the mass flow rates 

calculated were small, 1.925% maximum, which was considered to be acceptable. 
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Figure 18.   Consistency study of total pressure versus mass flow rate for Test Plan I 

0

0.1

0.2

0.3

0.4

0.5

0.6

0.7

0.8

0 0.2 0.4 0.6 0.8 1

Corrected mass Flow Rate [kg/s]

Ef
fic

ie
nc

y

Ref.4 Re-cal

 



Figure 19.   Consistency study of efficiency versus mass flow rate for Test Plan I 
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Figure 20.   Consistency study of thrust versus mass flow rate for Test Plan I 
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Figure 21.   Consistency study of thrust versus power for Test Plan I 

 
2. Test Plan II 

As in the comparison for Test Plan I, the characteristic curves, shown in Figures 

22-25, were not exactly the same, but the trends of total pressure ratio, total temperature 

ratio and efficiency versus mass flow rate were acceptable since they were close to the 

values originally calculated in [Ref. 4]. However, the relationship of thrust versus mass 

flow rate was linear once it was re-calculated; it was not quadratic as presented in [Ref. 

4]. And the curves of the power versus mass flow rate shifted up a lot at higher rotational 
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speeds. Therefore, in order to make the present study consistent, the current calculational 

procedure was utilized thereafter.  
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Figure 22.   Consistency study of total pressure ratio versus mass flow rate for Test Plan II 
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Figure 23.   Consistency study of efficiency versus mass flow rate for Test Plan II 
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Figure 24.   Consistency study of thrust versus mass flow rate for Test Plan II 
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Figure 25.   Consistency study of thrust versus power for Test Plan II 

 
E. PERFORMANCE OF THE BASELINE CONFIGURATION AT VARIOUS 

ROTATIONAL SPEEDS 
The results of Test Plan I were compared with the results of Simulation Plan I and 

the results shown in Figures 26-31. The re-calculated results of Cheng [Ref. 4] are also 

included. The results show a slight difference in the mass flow rate. There was a slight 

disagreement of the characteristic curves of total temperature ratio, efficiency and power. 

When the comparsion was made of the present experimental data but using different 

calculational procedures, i.e. using 3 exit combination probes vs 5 probes., more 

measuring probes improved the agreement in the total pressure ratio and efficiency, 
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however total temperature ratio and power deviated slightly. The thrust was similar for all 

calculational procedures and for both data sets, the present as well as [Ref. 4]. The 

computed (CFD) results were obtained using the same calculational procedure as in the 

experiment, i.e. using 3 or 5 exit probes. Over the complete speed range the total pressure 

ratio comparison was very good. However, the curve of the total temperature ratio (with 5 

probes) was higher than the experimental, which resulted in an under prediction of the 

efficiency. At low speeds the computed efficiency was too high, between 60 and 70%, 

and the trend was not correct as the drop off of efficiency with decreasing speed was not 

computed. 
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Figure 26.   Comparison of total pressure ratio versus mass flow rate for Test Plan I 
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Figure 27.   Comparison of total temperature ratio versus mass flow rate for Test Plan I 
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Figure 28.   Comparison of efficiency versus mass flow rate for Test Plan I 
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Figure 29.   Comparison of thrust versus mass flow rate for Test Plan I 
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Figure 30.   Comparison of power versus mass flow rate for Test Plan I 
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Figure 31.   Comparison of thrust versus power for Test Plan I 

 
F. OFF-DESIGN PERFORMANCE AT VARIOUS ROTATIONAL SPEEDS  

First, the results of Test Plan II are presented and compared with the recalculated 

data of Cheng [Ref. 4]. In Figure 32-37, the CFF constant speed characteristics are shown 

based on the use of 5 probe measurements at the outlet plane. It can be seen that, which 

the levels of pressure ratio and temperature ratio were fairly similar at the different 

speeds, the range of mass flow rates from open to closed throttle were quite different, 

particularly at the lower speeds. At full open and stall throttle setting, the mass flow rate 

measured at 2000RPM was 15.25% and 77.54% less, respectively. At the higher 

rotational speed of 5000RPM, the mass flow rate measurements compared more 

favorably, however, the present measurements were down by 7.69% and 43.93% at open 

throttle and stall respectively.  

A likely explanation for the discrepancy in mass flow rate measurments was that 

more accurate pressure transducers were used in the present study; i.e. the digital sensor 

array. To confirm this, an uncertainty analysis was performed. For Test Plan I, the 

uncertainties at 1000 RPM and 5000RPM were 3.72% and 0.16%, respectively, or 

averaged uncertainty, 1.94%. For Test Plan II, the uncertainty was 18.62% at the stall 

throttle position at 2000RPM, and the uncertainty was 0.13% at the full open throttle 
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position at 5000RPM. The overall average uncertainty was 2.39%. Detailed equations for 

uncertainty are given in APPENDIX C.  
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Figure 32.   Comparison of total pressure ratio versus mass flow rate for Test Plan II 
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Figure 33.   Comparison of total temperature ratio versus mass flow rate for Test Plan II 
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Figure 34.   Comparison of efficiency versus mass flow rate for Test Plan II 
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Figure 35.   Comparison of thrust versus mass flow rate for Test Plan II 
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Figure 36.   Comparison of power versus mass flow rate for Test Plan II 
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Figure 37.   Comparison of thrust versus power for Test Plan II 
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Next, the combined performance of the baseline configuration (Test Plan I) and 

throttling test cases (Test Plan II) are shown together in Figures 38–40. As to be 

expected, the baseline characteristic intersected the constant speed characteristic curves. 

The exit diffuser extended the performance of the CFF by increasing its open-throttle 

mass flow rate and the throttle varied the performance up to a stall condition at the low 

mass flow rates. Peak efficiency occurred after closing the exhaust duct a certain amount 

at each speed. The peak efficiency was within 62% to 72%, and it increased with 

increasing speed over the range of speeds tested.  

As discussed earlier, the mass flow rate measured in Cheng [Ref. 4] for Test Plan 

II was higher than that in the present experimental results. If the same combined 

performance were plotted, there would be no intersection between the two configurations, 

which supports the questioning of the previous data.  
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Figure 38.   Combination plot of Test Plan I and Test Plan II for total pressure ratio versus 

mass flow rate  
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Figure 39.   Combination plot of Test Plan I and Test Plan II for total temperature ratio 

versus mass flow rate 
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Figure 40.   Combination plot of Test Plan I and Test Plan II for efficiency versus mass 

flow rate 
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Finally, the present experimental results (Test Plan II) were compared to the 

computed solutions (Simulation Plan II) as shown in Figures 41-43. The predicted 

characteristic curves were calculated in the same manner as the experiments except that 

the mass flow rate in the simulation was obtained directly from the inlet boundary. The 

numerical solutions for each specific rotational speed followed its corresponding 

experimental characteristic curve.  

Figure 41 shows that the comparison of total pressure ratio versus mass flow rate. 

For the rotational speed of 2000RPM and 3000RPM, the performance was well predicted. 

At 5000RPM, it was observed that the difference at the open throttle position was the 

largest; however, the flow rate prediction was only 2.06% less than the experiment. Near 

stall the predictions were also very good, particularly since the calculations tended to 

become unstable. The data presented at the lowest mass flow rates at each speed was the 

last stable numerical point. Figure 42 shows the comparison of total temperature ratio 

versus mass flow rate. Although the predicted curves qualitatively followed the 

experimental curves, the total temperature ratio predicted was lower when stall occurred. 

The lack of agreement at low flow rates would indicate that the boundary layers within 

the flow-field were not adequately resolved. Figure 43 shows the efficiency predicted for 

different rotational speeds. At 5000 RPM the predicted peak efficiency of 72% was very 

close to that measured and the disagreement in efficiency was largest at open throttle and 

near stall. The predicted peak efficiency at 2000RPM was off by 15%; however the 

overall trend was reasonable. At open throttle, the differences between calculation and 

experiment were 6% and 20% for 2000RPM and 5000RPM respectively. The 

calculations also showed that the CFF could be run at larger diffuser angles; i.e. higher 

mass flow rates. 
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Figure 41.   Comparison of experimental and computed results for total pressure ratio 

versus mass flow rate 
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Figure 42.   Comparison of experimental and computed results for total temperature ratio 

versus mass flow rate  
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Figure 43.   Comparison of experimental and computed results for efficiencies versus 

mass flow rate 
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V. SUMMARY AND CONCLUSIONS 

The CFD study was initially carried out with the intension of predicting the 

performance data of Cheng [Ref. 4]. Results of the prediction of the throttling 

configurations raised the question of the accuracy in the previous experiments. An 

improved experiment was therefore undertaken as reporeted here. When compared with 

accurate experimental data, the overall off-design performance of the CFF was 

numerically well predicted. Specifically, the comparison of computed and experimental 

results was made by employing the same calculating procedure for both.  The study also 

indicated that the standard day conditions would be a better boundary condition when 

setting up the model. Moreover, the consistency study supported the contention of some 

error in the deterimentation of mass flow rate in Cheng [Ref. 4]. The Mach number 

distribution in the flow field at 3000RPM at stall is shown in Figure 44. The flow 

entrained into the CFF moved closer to the HPC, while the vortex around the LPC 

became larger, pushing the flow to the left. The zone of lower velocity  increased and the 

mass flow rate was hence reduced. A dramatic drop-off in efficiency occurred because of 

the attendant viscous mixing losses.  

 
Figure 44.   Distribution of Mach at 3000RPM with stall position setting 

 

With the present successful modeling, more configurations of the 12-inch rotor 

can be computed and compared to the experimental results, particularly at higher 
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rotational speeds and higher exit diffuser angles. Furthermore, a case study of the 6-inch 

rotor with various spanwise lengths should be computed using the procedures presented.   



APPENDIX A. CFF_DAQ STRUCTURAL TREE 
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APPENDIX B. MASS FLOW RATE MEASUREMENT OF THE 
CFF  

Mass flow rate can be obtained using the continuity equation and introducing the 

 

equation of state; it is then 

here is measured directly from static tapes at bell-mouth; 

1

1
in

Pm A
RT

= V

 

w  1P  A  is the cross-sectional 
area of the bell-mouth, 4/2DA π= , 52.6 ′′=D ; R is gas constant. However, 1T  and inV  
are unknown and have t la parameters which can be measured. The 
procedure for finding 1T  and inV  is as follows: 
 

o be calcu ted from 

From steady flow energy equation for a perfect gas;  
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APPENDIX C. UNCERTAINTY STUDY  

In APPENDIX B, the description of derivation of mass flow was made, and it can be 
expressed in the form of  

( ) ( 111
1111

1 ,,
,,

PPTAV
PPTRT

Pm ttin
tt

= )    (C.01) 

1tT , , 1tP P  and A  are independent variables and measured from instruments, whose 
corresponding uncertainties are provided in Table C.01 
 

Variable Accuracy,  w

1tT  C°±1  ( ) 
1tTw

1tP  bar001.0±  ( ) 
1tPw

1P  %05.0±  ( ) 
1Pw

A  2 0001.0 inπ±  ( ) Aw

Table C.01     Uncertainty in each measurement 
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where each w  presents the uncertainty in each measurement, and their corresponding 
derivatives were found as 
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Now, there are six more derivatives to be determined,  
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Substituting Eq. (C.07), (C.08) and (C.09) into Eq. (C.10), (C.11) and (C.12), 
respectively, then all derivatives were expressed in terms of independent variables. 

Once all derivatives required were found, substitute them back to Eq. (C.02), then the 
uncertainty in the mass flow rate was determined.  
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APPENDIX D. GEOMETRY GENERATION IN ICEM-CFD 

1. Starting a New Project 

a) Launch ANSYS ICEMCFD-CFX 

Select File > New Project from the Main menu and click on (Create New Directory) 
and enter Directory name as in Figure D01. 

Figure D01: New Project Window 

 

2. 2-D Model Generation 

2.1. Blade generation 

a) Point Creation 

Geometry > Create Point > Explicit Coordinates: Select the  (Explicit coordinate) 
to open the Explicit Location window as shown in Figure D02. 

As shown in Figure D02, Select Create 1 point, and assign coordinates (0 0 0). Input the 
Part name POINTS, and the Name as POINTS.00 and press Apply to create a point. 
This is a reference point when Import Geometry is required. 
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Figure D02: Point creation window 

 

Figure D03: Select point-data window 

 

Select File > Import Geometry > Formatted point data from the Main menu and 
choose Blade.txt as shown in Figure D03. Press Open, the window shown as Figure D04 
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appears. Uncheck Import Curves, Import Surfaces and Plot3D Format, Then Set 
Approximation Tolerance to 0. Keep the name of Point Part as default. To accept the 
points by click Apply, then it is read and shown in Figure D05. 

Figure D04: Import formatted point data window 

 

Figure D05: Points after importing 
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b) Line Creation 

Geometry > Create/Modify Curve > Arc from 3 Points: Select the  (Are from 3 
Points) to open the From Points window as shown in Figure D06. 

Figure D06: Are from 3 points window 

 

Unclick on Allow work-plane selection. To select Points, click on (Entity chooser 
icon) and then select pnt0, pnt1 and pnt2 with the left-mouse button. Press the middle 
mouse button to accept the points. The points name will appear in the select window. 
Enter the Part to BLADES, and Name to BLADES.00. Press Apply to create a curve. 

Similarly make other lines by just selecting the points below, the curves name will then 
change by default. 

BLADES.01:     pnt4, pnt5 and pnt6 

BLADES.02:     pnt0, pnt8 and pnt6 

BLADES.03:     pnt2, pnt7 and pnt4 
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TIP2: At any time during the selection process, pressing F9 will allow the user to
zoom, rotate or pan to get a better view. Toggle F9 again will return the user to
selection mode. 
TIP1: Switch ON the Points in the left side model Tree window. To see the names of
the points, use the right mouse and select button Points > show Points Names in the
model Tree window. To turn Off Points Names, click button Points > show Points
Names in the model Tree window again. 



 

 

 

F

G
G

F

S

TIP3: To see the names of curves, use the right mouse and select button Curves >
show Curves Names in the model Tree window. It is shown in Figure A07. 
igure D07: Geometry after blade curves generated 

 

eometry > Transform Geometry > Translate Geometry: Select the (Translate 
eometry) to open the Select window as shown in Figure D08.  

igure D08: Translation method window 

 

witch ON Points and Curves in the left side model Tree window. 
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To select Translating objects, click on (Entity chooser icon) and there is a Select 

Geometry bar popping up. Switch off (Toggle selection of surfaces or shells) and 

(Toggle selection of bodies or volume element) at the right side of this bar as shown 

in Figure D09. Then select (all appropriate visible objects). Click off Copy and set X 
Offset to 4.225, Y and Z Offset to 0. Press Apply to translate points and curves. 

Figure D09: Selection geometry tool bar window 

 

Geometry > Transform Geometry > Rotate Geometry: Select the (Rotate 
Geometry) to open the Select window as shown in Figure D10.  

Figure D10: Rotation select window 
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To select Rotating objects, click on and Click on from Select Geometry after 

switching off and . Under Rotation, set on Axis to Z, and set Angle to 32.605. 
Under Center of Rotation, set Center Point to Specified and Location to (4.225 0 0). 
Press Apply to rotate points and curves. 

c) Blade Surface Creation 

Geometry > Create/Modify Surface > From Curves: Select the (From Curves) to 
open the Select Curves window as shown in Figure D11.  

Figure D11: Select curves window 

 

To select Curves, click on and select BLADES.00, BLADES.01, BLADES.02 and 
BLADES.03 with the left mouse button. Press the middle mouse button to accept the 
curves. The curves name will appear in the select window. Set Tolerance to 0, and enter 
the Part as BLADES, and Name as BLADES.00. Press Apply to create the surface. 
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TIP4: To regroup Parts, double-click Parts in the left side model Tree window with
the left-mouse button, the Create Part window appear as shown in Figure A12.
Switch OFF Curves and Surfaces in the left side model Tree window. Set Parts to

POINTS and click on from Select Geometry. The imported points are joining
into POINTS by pressing Apply. 
 
TIP5: To delete empty Parts, click Parts > Delete Empty Parts in the model Tree
window. 
eometry > Transform Geometry > Rotate Geometry: Switch ON Curves and 
urfaces in the left side model Tree window. Switch OFF Points. To select rotating 

bjects, click on and select from Select Geometry after switching , and 

 on, then Check Copy and Set Number of copies to 29. Under Rotation, set Axis 
o Z. Set Angle to 12 and Center of Point to Origin. Press Apply to copy curves and 
urfaces. The result is shown in Figure D13. 

igure D12: Create part window 
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Figure D13: Geometry after blade surface generated 

 

Figure D14: Center and 2 points window 

 

d) Surface around blade Creation 

Geometry > Create/Modify Curves > Circle or arc from Center point and 2 points 

on plane: Select the  (Circle or arc from Center point and 2 points on plane) to open 
Center and 2 points window as shown in Figure D14. 
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To select Center Point, click on and select point with coordinate ( 0 0 0) with the left 
mouse button. Press the middle mouse button to accept the point. If there is no such 
point, then create one. The point name will appear in the select window. Enter the Part to 
INNERCIRCLE, and set Name to INNERCIRCLE.00. Set Radius to 4.1, and Press 
Apply to create the circle. Similarly make other circle with Radius equal to 6. Enter the 
Part to OUTERCIRCLE, and set Name to OUTERCIRCLE.00.The result is shown in 
Figure D15. 

Figure D15: Geometry after two circles created 

 

Geometry > Create Points > Parameter along a curve: Select the  (Parameter 
along a Curve) to open Parameter along a Curve window as shown in Figure D16. 

To select Curve, click on and select BLADES.00 with the left mouse button. Press 
the middle mouse button to accept the curve. Enter the Part as POINTS, and set Name 
by default. Set Curve parameters to 0.5. Press Apply to create the point. Similarly make 
center points for other three edges of a blade. 

Repeat the same steps to create center points for other blades. The final result is shown in 
Figure D17. 
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Figure D16: Parameter along a curve window 

 

Figure D17: Geometry after center point at each edge of blades created 
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Geometry > Create Points > Project point to curve: Select the  (Project point to 
Curve) to open Project Point to Curve window as shown in Figure D18.  
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Figure D18: Project point to curve 

Project points created at lead usly to INNERCIRCLE and 
OUTERCIRCLE respectively. Enter the Name by default.  

 

ing edge and trailing edge previo
Part to POINTS, and set 

Geometry > Create/Modify Curve > Segment curve: Select the  (Segment Curve) 
to open Segment Curve window as shown in Figure D19. 

To Segment INNERCIRCLE by selecting four points with almost even distance. Enter 

Geometry > Create/Modify Surface > From Curves: To make inner circle surface by 

CLE and OUTERCIRCLE for OUTERCIRCLE. Set 
Name by default for both cases. 

the Part as INNERCIRCLE, and set Name by default.  

selecting four segmented curves with tolerance equal to 0.000001. Enter the Part as 
SYM1, and set Name by default. 

Geometry > Create/Modify Curve > Segment curve: Continue to split INNERCIRCLE 
and OUTERCIRCLE by other points on them respectively. Enter the Part to 
INNERCIRCLE for INNERCIR

In the same manner, split curves BLADES.00 and BLADES.01 with the points at the 
center respectively. Repeat the same steps for other blades. Enter the Part as BLADES, 
and set Name by default. 



Geometry > Create/Modify Curve > From Points: Select the  (From Points) to 
open From Points window as shown in Figure D20.  

To create curves between blades and circles by joining two points and set Tolerance to 0, 

Geometry > Create Points > Parameter along a curve: Select each segment curve on 

enter the Part to CURVES, and set Name by default. The result is shown in Figure D21.  

INNERCIRCLE and OUTERCIRCLE. Enter the Part as POINTS, and set Name by 
default. Set Curve parameters to 0.5. Press Apply to create the points. 

Geometry > Create/Modify Curve > Segment curve: Segment circles again by the 
points just created.  

Geometry > Create Point > Parameter Along a Vector: Select the  (Parameter 
along a Vector) to open Parameter along a Vector window as shown in Figure D22.  

To select 2 points, click on and select points at the center of the pr re edge and 
suction edge with the left mouse button. Press the middle mouse button to accept the 
point. Set Parameter(s) to 0.5, Enter the Part as POINTS, and set Name by default. 

essu

Press Apply to create points. 

Geometry > Create/Modify Curve > Arc from 3 Points: Create Curves between blades 
as shown in Figure D23, Enter the Part as CURVES, and Name by default. 

Geometry > Create/Modify Surface > From Curves: To select Curves, click on  
and select curves shown in Figure D24 with the left mouse button. Press the middle 
mouse button to accept the curves. Enter the Part as SYM1, and Name by default, Set 
Tolerance to 0.001. Press Apply to create the surface. 

 

 

Follow the same steps and Repeat 59 times to create other surfaces around blades, be sure 
that curves can enclose an area. 
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igure D19: Segment curve windowmove this to the next page – check all the way 
rough 

Figure D20: Form

 

 

F
th

 

 points window 
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Figure D21: Geometry after assistant curves created 

 
 

Figure D22: Parameter along a vector window 
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Figure D23: Geometry after assistant curves created 

 

Figure D24: The selection of surface creation around the blad

 
 

e 

 

2.2. Cavities, Inlet, Outlet Section Generation 

a) Points Creation 

Select File > Import Geometry > Formatted point data from the Main menu and 
choose Cavities.txt as shown in Figure D03. Uncheck Import Curves, Import Surfaces 
and Plot3D Format, then Set Approximation Tolerance to 0. To accept the points by 
click Apply, then it is read and shown in Figure D25. 
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Figure D25: Geometry after cavities points imported 

eometry > Create/Modify Curve > From Points: To select Points, click on 

 

b) Line Creation 

G and 
en select pnt9, pnt10, pnt11, pnt12, pnt13, pnt14, pnt15 and pnt16 with the left 
ouse button. Press the middle mouse button to accept the points. The points name will 

ppear in the select window. Set Tolerance to 0, Enter the Part to WALL, and Name to 
ALL.00. Press Apply to create the curve for high pressure cavity. 

points, Leave the Part as WALL 
and Name by default. 

WALL.01:        pnt28, pnt29, pnt30, pnt31, pnt32, pnt33, pnt34 and pnt35 (Low 

Pressure Cavity)  

WALL.02:        pnt18, pnt19, pnt20 and pnt21 (Inlet Section) 

WALL.03:        pnt37, pnt38, pnt39, pnt40 and pnt41 (Inlet Section) 

WALL.04:        pnt25, pnt26 and pnt.27 (Set Tolerance to 0.00001, others are 0) 

(Outlet Section) 

WALL.05:        pnt43 and pnt44 (Outlet Section) 

OUTLET.00:      pnt27 and pnt44 (Set Part as OUTLET and Name as 

OUTLET.00) (Outlet Section) 

th
m
a
W

Similarly make other curves by selecting the following 
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Geometry > Create/Modify Curve > Arc from 3 Points: Click on and then select 
pnt16, pnt17 and pnt18 with the left mouse button. Press the middle mouse button to 
accept the points. The points name will appear in the select window. Enter the Part as 
WALL and Name as WALL.06. Press Apply to create the curve. 

Similarly make other lines by selecting the group of points shown below separately: 

WALL.07:        pnt9, pnt22 and pnt23 

WALL.08:        pnt23, pnt24 and pnt25 

WALL.09:        pnt28, pnt42 and pnt43 

WALL.10:        pnt35, pnt36 and pnt37 

INT0.00:         pnt23, pnt49 and pnt43 (Set Part as INT0 and Name as INT0.00) 

INT1.00:         pnt28, pnt47 and pnt35 (Set Part as INT1 and Name as INT1.00) 

INT2.00:         pnt37, pnt48 and pnt18 (Set Part as INT2 and Name as INT2.00) 

INT3.00:         pnt22, pnt46 and pnt16 (Set Part as INT3 and Name as NT3.00) 

Figure D26: Geometry after wall, outlet and interface created 

 

Since

Geometry > Create/Mod plit curve WALL.02 by point 
pnt20. 

I

 Inlet section is not complete, it is needed to continue the curve generation: 

ify Curve > Segment curve: S



Geometry > Delete Any Entity: Select the  (Delete Any Entity) from the main 
toolbar. Delete the curve between points: pnt20 and pnt21. 

Geometry > Create/Modify Curve > Modify Curves: Select the  (Modify Curves) 

To select Cu

to open Modify Curves window as shown in Figure D27. 

rve, click on and then select previous segment curve with the left mouse 
butto ccept the curve. In the same manner, set 
Loca L, and Name by default. Press Apply to 
create the cu

Conti is 
shown in Figure D28, Set  
as W

Similarly extend a curve WALL.03 by setting 
final 

n. Press the middle mouse button to a
tion to pnt21. Enter the Part as WAL

rve. 

nue to extend the curve, under End point selection, click Length and the window 
Length to 25. Under Extend as, Click on Line. Enter the Part

ALL, and Name by default. Press Apply to extend the curve. 

Length to 25, and extend as a Line. The 
curves are shown is Figure D29. 

Figure D27: Modify curves by selecting end point window 
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Figure D29: Geometry after curves extended at inlet section 

 
 

Geometry > Create/Modify Curves > Circle or arc from Center point and 2 points 
on plane: To create a circle with radius 25 along center point (0 0 0). Enter the Part as 
INLET, and set Name to INLET.00. Press Apply to create a circle. 

Figure D28: Modify curves by extending length window 
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Geometry > Create Point > Curve-Curve Intersection: Select the  (Curve- Curve 
Intersection) to open the Curve-Curve Intersection window as shown in Figure D30. 

Figure D30: Curve-Curve intersection window 

 

To select Curve, click on and then select INLET.00 and extended Curves with the 
left mouse button. Press the middle mouse button to accept the curve. Set Gap tolerance 
to 0.000001, Enter the Part as POINTS, and Name by default. Press Apply to create 
point as shown in Figure D31. 

Figure D31: Geometry after circle with radius 25 inch and intersection points created 

rve INLET.00 and 
extended curves WALL.03 and WALL.04 with two intersection points. 

 

Geometry > Create/Modify Curve > Segment curve: Spilt Cu



Geometry > Delete Any Entity: Select the  from the main toolba elete the curves 
and the final geometry is shown in Figure D32. 

r. D

 

 

P

G
m
c
S
s

 
 
 
 

Figure D32: Geometry after inlet section created

 

 

c

 
 

TIP6: To see the better color distribution, use the right mouse and select button Part
> Good Colors in the model Tree window. 
ressure Cavity generation 

eometry > Create/Modify Surface > From Curves: Select curves around with the left 
ouse button. Press the middle mouse button to accept the curves. No matter there is four 

urves or not, as long as the area is closed, the surface will be generated. For Inlet 
ection, High Pressure and Low Pressure Cavity, set Tolerance to 0. For Outlet Section, 
et Tolerance to 0.00001. And it is shown in Figure D33. 

74 

) Surface for Inlet Section, Outlet Section, High Pressure Cavity and Low 
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t se

In order to generate the su ith radius 6-in) 
 low pressure cavity), 

there are more assistant points and curves required. 

G o curve: Project points on OUTERCIRCLE 
 its outer curves corresponding to inlet section, outlet section, high pressure cavity and 

 pressure cavity. Enter the Part as POINTS, and leave Name by default. Similarly 

 Figure D34. 

INT5.00         pnt17 and its projected point on OUTERCIRCLE (Set Part as INT5 

and Name as INT5.00) 

INT6.00         pnt23 and its projected point on OUTERCIRCLE (Set Part as INT6 

and Name as INT6.00) 

Figure D33: Geometry after surface at inle ction, outlet section, high pressure cavity 
and low pressure cavity created 

 

rface between OUTERCIRCLE.00 (A circle w
and 4 sections (inlet section, outlet section, high pressure cavity and

eometry > Create Points > Project point t
to
low
create four points on curve OUTERCIRCLE by project points: pnt17, pnt23, pnt42, and 
pnt36. 

Geometry > Create/Modify Curve > Segment curve: Split the curves by the points 
projected previously.  

Geometry > Create/Modify Curve > From Points: Create curve between the gaps by 
two corresponding points created previously. Set Tolerance to 0, enter the Part as 
CURVES and set Name by default. However, there are four curves excluded and shown 
in
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0) 

INT8.00         pnt36 and its projected point on OUTERCIRCLE (Set Part as INT8 

and Name as INT8.00) 

PS: The part INT4 is kept for an assistant curve for future mesh generation and it will be 
created at next section. 

Geometry > Create/Modify Surface > From Curves: Select curves, basically four 
curves create a surface, but even there are no four curves, a surface will be created due to 
enclosed area. Follow the steps indicated and Set Tolerance to 0.001. Enter the Part as 
SYM1, and leave Name by default.  

If there are more points or curves needed, follow the steps above to create them. The 
result is shown in Figure D34 and four particular areas are indicated.  

d) Assistant Curves for Future Mesh Generation 

There is a curve which will be used for future Mesh Generation, and it is created by 
following steps: 

nd set Name by default. 

ted previously, other one is pnt42) and make an arc shown in Figure D35. Enter 

 
 
 
 
 

INT7.00         pnt42 and its projected point on OUTERCIRCLE (Set Part as INT7 

and Name as INT7.0

Geometry > Create Points > Parameter along a curve: Set Curve Parameter(s) to 0.8 
and select curve shown at the right of Figure D35. Similarly make a point as shown in a 
middle of Figure D35. Enter the Part as POINTS, a

Geometry > Create/Modify Curve > Segment curve: Split the curve by point created 
previously. 

Geometry > Create/Modify Curve > Arc from 3 Points: Click on three points (2 points 
are crea
the Part as INT4, and set Name to INT4.00. 
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Figur

 

. 3-D Model Generation 

) Extrude 0.1 inch along Z-axis 

e D34: Geometry after surface between outer circles generated 

 

Figure D35: Geometry after assistant curve for future mesh generation 

3

a
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 0 0.1). Enter the 
Part as POINTS, and leave Name by default. 

Geometry > Create/Modify Surface > Sweep Surface: Select the 

Geometry > Create Point > Explicit Coordinates: Create a point (0

(Sweep 
Surface) to open the Select window as shown in Figure D36.  

Figure D36: Sweep surface window 

 

Set Method to Screen Vector, and set Vector to two points (0 0 0) and (0 0 0.1). Switch 
ON Curves in the left side model Tree window. Switch OFF the Part of CURVES and 
INT0 in the left side model Tree window. Enter Part as SURFS and Name as 

SURFS.00. After clicking on Entity chooser icon, select from Select Geometry. 
Then press Apply, geometry is created. 

Regroup each Part by following the TIP4 mentioned previously, and let all curves to the 
Part of CURVES, all points to the Part of POINTS. Others are indicated and shown in 
Figure D37. 

 

 
 

 



Figure D37: Geometry after extruded 
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Geometry > Transform Geometry > Translate Geometry: Translate SYM1, including 
curves and surfaces, and copy along Z-axis about 0.1-inch by selecting Explicit Method. 

Regroup the translated surface by following the TIP4 mentioned previously, and Let its 
Part as SYM2. 

Similarly translate blade surfaces about 0.1-inch along Z-axis to enclose the blades. 

b) Body Creation 

Geometry > Create Body > Material Point > Centroid of 2 points: Select the  
(Create Body) to open create body window as shown in Figure D38. Enter Part name 
FLUID and select two point (0 0 0) and (0 0 0.1) with the l  mouse button. Press the 
middle to accept the selection. Press Apply to create the mater  point. 

eft
ial

 
 
 
 
 
 
 



Figure D38: Create body window 
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4. Mesh Generation 

4.1. Inner Circle Mesh 

a) Starting Blacking 

 > Initialize blockBlocking > Create Block : It will open the Create B
window as shown in Figure D39. 

lock 

Type to 3D. And select two inner-circle surfaces on planes 
SYM1 and SYM2. Name Part as FLUID and press Apply to create block. 
Under Initialize Block, set 

Blocking > Associate  > Associate Vertex : It will open the window as shown 
in Figure D40. Toggle ON Geometry > Points and Blocking > vertices > Numbers from 
tree widget. Under Entity, select Point and associate vertex to point as shown in Figure 

41. D

 
 
 
 
 



Figure D39: Create block window 
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Figure D40: Associate vertex window 

 
 
 
 
 
 
 



Figure D41: Moving vertices 

 

Blocking > Associate > Associate Edge to Curve : It will open the window as 
shown in Figure D42 and Associate edges to curves as shown in Figure D43. 

Figure D42: Associate edge to curve window 

 

 

 

 

 

 

TIP: To make sure the association is correct by selecting Edges > Show Association
from the Tree Widget and switch on Curve 
82 
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 to curves 

 

Figure D43: Associating edges

Blocking > Split Block > Ogrid Block : It will open the Ogrid block window as 
shown in Figure D44. Select Face(s) as shown in Figure D45, Set Offset to 1. Press 
Apply to create O-grid block. 

Figure D44: O-grid block window 

 

igure D45:  

 

F
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Blocking > Pre-Mesh Params >Edge Param(s) : It will open the Meshing 
Parameters window as shown in Figure D46. To create the mesh as shown in Figure 

 on each edge, toggle Pre-Mesh from tree widget, then the 
t Mesh before saving the file by following steps:  

Use the right mouse and select Pre-Mesh > Convert to Unstruct Mesh in the model 
Tree window. 

Figure D46: Meshing parameters window 

 

D47, Select edges and enter their nodes as 36 or 18. Let Mesh law as BiGeometric and 
Check Copy to parallel edges.  

After setting up the parameters
mesh is created. Convert it to Unstruc
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ompleted center-circle mesh Figure D47:  C

 

4.2. Blades Mesh 

Blocking > Create Block  > Initialize block : Under Initialize Block, set Type 
to 2D Planer. Name Part as FLUID and press Apply to create a single block. 

Blocking > Associate  > Associate Vertex : Toggle ON Geometry > Points 
and Blocking > vertices > Numbers from tree widget. Under Entity, select Point. And 
associate vertex to appropriate point as shown in Figure D48. 

Figure D48: Moving vertices to points  
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Blocking > Associate > Associate Edge to Curve : To associate block edges to 
appropriate curves as shown in Figure D49. 

Figure D49: Associating edges to blade-curves 

 

Blocking > Split Block > Split Block : Select the Top edge with the left mouse 
button, try to position the edge at the required position as shown in Figure D50, then 
press the middle mouse button to accept the selection. Create other split also. 

 

Blocking > Associate 

Figure D50:  

> Associate Edge to Curve : Associate inner block edges 
to appropriate blade-curves. 

Blocking > Associate  > Associate Vertex : Associate vertices at inner block to 
appropriate points at the blade. 
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teBlocking > Move Ver x  > Move Vertex : Directly click on edges and move 
them to appropriate location as shown in Figure D51. 

e location  

 

Blocking > Split Block 

Figure D51: After moving vertices to appropriat

> Ogrid Block : Set Offset to 0.3 and Check Around 
Block(s). Select the block at center one as shown in Figure D52, and Apply to create O-
grid block.  

Figure D52: Select the block for the O-grid 
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Blocking > Edit Edge  > Split Edge :  To open Edit Edge(s) window as shown 
in Figure D53. Set Split type to Linear, then to split appropriate edges. Also use 
Blocking > Move Vertex > Move Vertex to move and arrange the edge as shown in 
Figure D54. 

Figure D53: Edit edge window 
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Figure D54: After arranging the shape of the block 

 

Blocking > Pre-Mesh Params  >Edge Param(s) : Set the number of nodes on 
Copy to paralle

 

fter setting up the parameters on each edge, toggle Pre-Mesh from tree widget, then the 
esh is created as shown in Figure D56. 

each edge as shown in Figure D55. Check l edges and Copy absolute. 
Then press Apply to accept. 

Figure D55: Nodes at each edge  

 

A
m



Figure D56: Mesh created around single blade 
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Since this mesh is good enough, there are 29 blades remaining, it is suggested to rotate 
and copy this Block to other corresponding blades. Before the action, disassociate Edges 
and Vertices first. 

Toggle Pre-Mesh from tree widget again to close the mesh 

Blocking > Associate > Disassociate form Geometry : To open Disassociate 
window as shown in Figure D57. 

To select Edges, click on and then select  from Select Blocks bar window. Press 
Apply to disassociate the edges. 

Blocking > Transform Blocks > Rotate Blocks : To open selection window. 

To select Rotating objects, click on and Click on from Select Blocks. Check 
Copy and set Number of copies to 29. Under Rotation, set on Axis to Z, and set Angle 
to 12. Under Center of Rotation, set Center Point to Origin. Press Apply to rotate 
blocks. 

Blocking > Associate > Associate Edge to Curve : Re-associate edges to 
appropriate curves. And check if the nodes on edge are changed or not. If there are extra 
vertices, delete them by Blocking > Edit Edge > Unsplit Edge, under Remove splits, set 

ingle.  

own in Figure D59 

S

After complete the previous step, to see how the meshes look like, toggle Pre-Mesh from 
tree widget, then the mesh is created as sh



Figure D57: Disassociate window 
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bloFigure D58: Rotation ck selection window 
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reation 

 

Blocking > Create Block 

Figure D59: After 2D blade mesh c

> 2D to 3D : To open Method window as shown in 
Figure D60. Set Method to Translate and Z Distance to 0.1, others are 0, press Apply to 
create 3D block. 

Figure D60: Method window 
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e quality of the meshes, disassociate edges 
and associate edges to curves if required. The final look of the meshes is shown in Figure 
61. 

Figure D61:  

 

4.3 Inlet Section Mesh 

Toggle Pre-Mesh from tree widget to see th

Blocking > Create Block  > Initialize block : Under Initialize Block, set Type 
to 3D. And select two opposite surfaces at inlet section. Name Part as FLUID and press 
Apply to create block. 

Blocking > Associate  > Associate Vertex : Toggle ON Geometry > Points and 
Blocking > vertices > Numbers from tree widget. Under Entity, select Point and 
associate vertex to point. 

Blocking > Associate > Associate Edge to Curve : Associate edges to curves 
as shown in Figure D62. 

Blocking > Pre-Mesh Params  >Edge Param(s) : Set the number of nodes on 
each edge as shown in Figure D63. Check Copy to parallel edges and Copy absolute. 
Then press Apply to accept. 

 

 



Figure D62:  
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rs on each edge, toggle Pre-Mesh from tree widget, then the 
mesh is created. Convert it to Unstruct Mesh before saving the file: Use the right 

ouse and select Pre-Mesh > Convert to Unstruct Mesh in the model Tree window. 
inal mesh at inlet section is shown in Figure D64. 

Figure D63:  

 

After setting up the paramete

m
The f

 



Figure D64:  
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4.4 Mesh between Inlet Section and Blades 

Blocking > Create Block  > Initialize block : Under Initialize Block, set Type 
to 2D Planer. Name Part as FLUID and press Apply to create a single block. 

Blocking > Associate  > Associate Vertex : Toggle ON Geometry > Points 
and Blocking > vertices > Numbers from tree widget. Under Entity, select Point. And 
associate vertices to appropriate points. 

Blocking > Split Block > Split Block : Split the left and right edge. 

Blocking > Associate  > Associate Vertex : Associate vertices to appropriate 
points as shown in Figure D65. 
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igure D65:  

 

Blocking > Edit Edge

F

 > Split Edge :  To open Edit Edge(s) window. Set Split 
type to Linear, then to split appropriate edges. Also use Blocking > Move Vertex > 
Move Vertex to move and arrange the edge as shown in Figure D66. 

Figure D66:  

Blocking > Pre-Mesh Params 

 

 >Edge Param(s) : Check Copy to parallel 
e. 

 

edges and Copy absolut Set mesh parameter at each edge as shown in Figure D67. 

Figure D67:  
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oggle Pre-Mesh from tree widget and see mesh generated is proper or not. If it is 
cceptable, then follow the steps mentioned to generate meshes from 2D-3D. 

Blocking > Create Block

T
a

 > 2D to 3D : Set Method to Translate and Z 
Distance to 0.1, others are 0, press Apply to create 3D block. 

Toggle Pre-Mesh from tree widget again to see the quality of the meshes. If edges are 
not associated properly, disassociate edges first, and then associate edges to curves. 

4.4 Final Meshes 

The meshes of other sections have to be generated by the previous procedure, either by 
2D block to 3D block or 3D block only. It depends on the geometry. The m shes for each 
section are saved in different name. The final mesh was created by opening each mesh 
files and merging them into one mesh.  

l t solver: Select the 

e

4.5 Writing Output 

Output > Se ec (Select solver) to open the Select window as 
r  D68. Roll down to select CFX-5 solver.  

Figure D68 Solver Selection Window 

 
 

Output > Write input: Select the 

shown in Figu e

 (View input) to open the output file window as 
shown in Figure D69. In the directory, type the expected name such as *.cfx5, then press 
Done.  
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Figure D69 Output File Window 
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APPENDIX E. PROCEDURES OF SETUP IN CFX-PRE  

I. Defining the Transient Simulation 
A Creating a New Simulation 

1. If required, launch CFX-Pre. 

2. Select File > New Simulation. 

3. Click General in the New Simulation File Window. 

4. If required, set the path location to a different folder. 

5. Under File name type CrossFlowFan. 

6. Click Save. 

7. The Mesh tab is displayed. 

1. Select File > Import Mesh or click Import Mes

 
B Importing a Mesh 

h . 

2. Leave Mesh Format set to ICEM CFD. 

3. In the bottom left of the screen, under File click Browse . 

 directory, select CrossFlowFan.cfx5. 

5. Click Open. 

6. Set Mesh Units to in. 

7. Click Ok. 

8. The mesh is opened. 

C Define the Simulation Type 
In order to check if the solver will give convergent result or not, the first 
revolution is suggested and is set up as follows. 

1. Select Create > Flow Objects > Simulation Type

4. From the working

 from the main 
menu. 

Simulation Type appears 

2. Set Option to Transient. 

3. Under Time Duration, Set Option to Total Time, and Total time to 
0.02 [s]. 

4. Under Time Steps, Set Option to Timestep, and Timesteps to 
5.55555e-5 [s] 

5. Under Initial Time, Set Option to Automatic with Value, and Time 



to 0 [s] 
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6. Click Ok to save the information. 

main 

n

D Creating the Domain 
1. To Create Rotation Do

a) Click Create a Domai . 

ame to Rotation and click OK. 

Edit Domain: Rotation is displayed 

en

. 

 Fluid Domain. 

Set Fluid List to Air Ideal Gas. 

rame set to Coord 0. 

Set Reference Pressure to 1 [atm]. 

 Non Buoyant. 

e Option set to Rotating. 

. 

Under Axis Definition, leave Option set to Coordinate 
Axis. 

ion Axis to Global Z. 

k the Fluid Models tab and leave all options set to their 
aults except: 

at Transfer Model, leave Option set to Total 

ork Term. 

O -
Epsilon. 

reate the domain. 

ain 

b) In Create Domain, set N

c) On the G eral Options panel: 

(1) Set Location to Assembly, Assembly 3

(2) Leave Domain Type set to

(3) 
(4) Leave Coord F

(5) 
(6) Under Buoyancy, leave Option set to

(7) Under Domain Motion, leav

(8) Set Angular Velocity to 3000 [rev min^-1]

(9) Turn on Alternate Rotation Model. 

(10) 

(11) Set Rotat

d) Clic
respective def

(1) Under He
Energy. 

(2) Turn on Include Viscous W

(3) Under Turbulence Model, leave ption set to k

(4) Click Ok to c

2. To Create Stationary Dom

a) Click Create a Domain . 

b) In Create Domain, set Name to Stationary and click OK. 

Edit Domain: Stationary is displayed 

c) On the General Options panel: 
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 Set Location to Assembly 2, Assembly 4, Assembly 5, 
bly 7, Assembly 8, and Assembly 

ave Domain Type set to Fluid Domain. 

 Air Ideal Gas.  

e et to Coord 0. 

 set to Non Buoyant. 

ave Option set to Stationary. 

d)  set to their 

ave Option set to Total 

m. 

k-

e) k

E Creating the B d
1. To Create the

a) 

(1)
Assembly 6, Assem
9, Assembly 10. 

(2) Le

(3) Set Fluid List to

(4) Leave Coord Fram  s

(5) Set Reference Pressure to 1 [atm]. 

(6) Under Buoyancy, leave Option

(7) Under Domain Motion, le

Click the Fluid Models tab and leave all options
respective defaults except: 

(1) Under Heat Transfer Model, le
Energy. 

(2) Turn on Include Viscous Work Ter

(3) Under Turbulence Model, leave option set to 
Epsilon. 

Clic  Ok to create the domain. 

oun ary Conditions 
 Inlet Boundary Condition 

Click Create a Boundary Condition on the main toolbar. 

b) onary, then Ok. 

c) , set: 

(2)  to INLET 

d) 

Option to Pressure 

 to 0 [Pa] 

ec n, set Option to Normal to 

 Medium (Intensity = 

Set Name to Inlet and Domain to Stati

Edit Boundary is displayed. 

On the Basic Settings panel

(1) Boundary Type to Opening 

Location

Click the Boundary Details tab, then: 

(1) Under Flow Regime, leave Option set to Subsonic. 

(2) Under Mass and Momentum, set 
and Direction (Stable). 

(3) Set Relative Pressure

(4) Under Flow Dir tio
Boundary Condition. 

(5) Under Turbulence, set Option to
5%). 
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(7) rature to 300 [K]. 

e) k

2. To Create the

a) 

(6) Under Heat Transfer, set Option to Static 
Temperature. 

Set Static Tempe

Clic  Ok to create the boundary. 

 Outlet Boundary Condition 

. Click Create a Boundary Condition

b) Name

pening 

d) Click the Boundary Details tab, then: 

 Subsonic. 

0 [Pa] 

irection, set Option to Normal to 

o  

Static 

300 [K]. 

e) k dition. 

3. To Create the y Condition 

Fir n Stationary Domain. 

a) k

Set  to Outlet and Domain to Stationary, then Ok. 

Edit Boundary is displayed. 

c) On the Basic Settings panel, set: 

(1) Boundary Type to O

(2) Location to OUTLET 

(1) Under Flow Regime, leave Option set to

(2) Under Mass and Momentum, set Option to Static 
Pressure. 

(3) Set Relative Pressure to 

(4) Under Flow D
Boundary Condition. 

(5) Under Turbulence, set Option t Medium (Intensity =
5%). 

(6) Under Heat Transfer, set Option to 
Temperature. 

(7) Set Static Temperature to 

Clic  Ok to create the boundary con

 Symmetry Boundar

st create the symmetric boundary condition i

Clic  Create a Boundary Condition . 

Set Name to SYM1and Domain to Stationary, then Ok. b) 
Edit Boundary is displayed. 

c) he 

(1) metry 

 
d) Click Ok to create the boundary condition. 

On t Basic Settings panel, set: 

Boundary Type to Sym

(2) Location to SYM1 C, SYM1 D, SYM1 E, SYM1 F, 
SYM1 G, SYM1 H, SYM1 I, SYM1 J
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Similar e p

a) 

ly cr ate the o posite symmetric boundary condition. 

. Click Create a Boundary Condition

b) Set Name to SYM2and Domain to Stationary, then Ok. 

c) On the Basic Settings panel, set: 

2 F, 
M2 I, SYM2 J 

ondition. 

Then cr  t on in Rotation Domain. 

a) k dition

Edit Boundary is displayed. 

(1) Boundary Type to Symmetry 

(2) Location to SYM2 C, SYM2 D, SYM2 E, SYM
SYM2 G, SYM2 H, SY

d) Click Ok to create the boundary c

eate he symmetric boundary conditi

. Clic  Create a Boundary Con

b) Set Name to SYM3and Domain to Rotation, then Ok. 

c) h

d) Click ry condition. 

Similar e

a) Click  a Boundary Condition

Edit Boundary is displayed. 

On t e Basic Settings panel, set: 

(1) Boundary Type to Symmetry 

(2) Location to SYM1 A, SYM1 B 

Ok to create the bounda

ly cr ate the opposite symmetric boundary condition 

Create . 

Set Name to SYM4and Domain to Rotation, then Ok. b) 
Edit Boundary is displayed. 

c) On the Basic Settings panel, set: 

(1) Boundary Type to Rotation 

(2) Location to SYM2 A, SYM2 B 

d) Click Ok to create the boundary condition. 

2. To Create the W

a) ndition

all Boundary Condition  

. Click Create a Boundary Co

b) Set Name to Wall and Domain to Stationary, then Ok. 

c) h

(3) 

Edit Boundary is displayed. 

On t e Basic Settings panel, set: 

Boundary Type to Wall 

(4) Location to Wall 



d) Click the Boundary Details tab, then: 

104 

, leave Option set to No 

. 

Option to Adiabatic. 

3. To Create the Blades Bo

a) Click 

(1) Under Wall Influence On Flow
Slip. 

, set Option to Smooth Wall(2) Under Wall Roughness

(3) Under Heat Transfer, set 

e) Click Ok to create the boundary. 

undary Condition  

Create a Boundary Condition . 

b) Set Name to Blades and Domain to Rotation, then Ok. 

hen: 

, leave Option set to No 

Smooth Wall. 

. 

D Creating D
1. To ary 

Domai

Edit Boundary is displayed. 

c) On the Basic Settings panel, set: 

(1) Boundary Type to Wall 

(2) Location to Blades 

d) Click the Boundary Details tab, t

(1) Under Wall Influence On Flow
Slip. 

(2) Under Wall Roughness, set Option to 

(3) Under Heat Transfer, set Option to Adiabatic

e) Click Ok to create the boundary. 

omain Interface 
create the interface between Rotation Domain and Station

n 

a) Click Create a Domain Interface on the main toolbar. 

b) erface 1), then Ok. 

id Fluid. 

tion. 

g) CIRCLE B, OUTERCIRCLE 
CIRCLE E. 

h) n me Change, set Option to 

i)  Option to Automatic. 

Leave Name by default (Domain Int

Edit Domain Interface is displayed. 

c) On Basic Setting, set Interface Type to Flu

d) Under Side 1, set Domain to Rota

e) Set Region List 1 to OUTERCIRCLE A. 

f) Under Side 2, set Domain to Stationary. 

Set Region List 2 to OUTER
C, OUTERCIRCLE D, OUTER

On I terface Models, under Fra
Transient Rotor Stator. 

Under Pitch Change, set



j) Click Ok to create the interface. 
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2. To crea e

a) Doma rface 2 

te th  interface in Stationary Domain 

in Inte

(1) Click Create a Domain Interface on the main 
toolbar. 

(2) Leave Name by default, then Ok. 

 Type to Fluid Fluid. 

 D ain. 

in to Stationary. 

CIRCLE  B. 

er Frame Change, set Option 

 to Automatic. 

 
b) Doma rface 3 

(3) On Basic Setting, set Interface

(4) Under Side 1, set Domain to All om

(5) Set Region List 1 to INTERCIRCLE  A. 

(6) Under Side 2, set Doma

(7) Set Region List 2 to INTER

(8) On Interface Models, und
to None. 

(9) Under Pitch Change, set Option

(10) Click Ok to create the interface. 

in Inte

(1) Click Create a Domain Interface on the main 
toolbar. 

(2) Leave Name by default, then Ok. 

 Setting, set Interface Type to Fluid Fluid. 

) Set Region List 1 to INT 1 A. 

ta

ame Change, set Option 

o Automatic. 

(3) On Basic

(4) Under Side 1, set Domain to Stationary. 

(5

(6) Under Side 2, set Domain to S tionary. 

(7) Set Region List 2 to INT 1 B. 

(8) On Interface Models, under Fr
to None. 

(9) Under Pitch Change, set Option t

(10) Click Ok to create the interface. 

c) Domain Interface 4 

(1) Click Create a Domain Interface on the main 
toolbar. 

(2) Leave Name by default, then Ok. 

(3) On Basic Setting, set Interface Type to Fluid Fluid. 
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to Stationary. 

set Domain to Stationary. 

(8) face Models, under Frame Change, set Option 

 
d) a

(4) Under Side 1, set Domain 

(5) Set Region List 1 to INT 2 A. 

(6) Under Side 2, 

(7) Set Region List 2 to INT 2 B. 

On Inter
to None. 

(9) Under Pitch Change, set Option to Automatic. 

(10) Click Ok to create the interface. 

Dom in Interface 5 

(1) Click Create a Domain Interface on the main 

(3) Setting, set Interface Type to Fluid Fluid. 

set Domain to Stationary. 

(8) face Models, under Frame Change, set Option 

 
e) a

toolbar. 

(2) Leave Name by default, then Ok. 

On Basic 

(4) Under Side 1, set Domain to Stationary. 

(5) Set Region List 1 to INT 3 A. 

(6) Under Side 2, 

(7) Set Region List 2 to INT 3 B. 

On Inter
to None. 

(9) Under Pitch Change, set Option to Automatic. 

(10) Click Ok to create the interface. 

Dom in Interface 6 

(1) Click Create a Domain Interface on the main 

(3) Setting, set Interface Type to Fluid Fluid. 

set Domain to Stationary. 

(8) face Models, under Frame Change, set Option 

(10) Click Ok to create the interface. 

toolbar. 

(2) Leave Name by default, then Ok. 

On Basic 

(4) Under Side 1, set Domain to Stationary. 

(5) Set Region List 1 to INT 4 A. 

(6) Under Side 2, 

(7) Set Region List 2 to INT 4 B. 

On Inter
to None. 

(9) Under Pitch Change, set Option to Automatic. 
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f) a

ce

Dom in Interface 7 

 (1) Click Create a Domain Interfa on the main 

k. 

(4) e 1, set Domain to Stationary. 

onary. 

st 2 to INT 5 B. 

ption 

 Automatic. 

 
g) a

ce

toolbar. 

(2) Leave Name by default, then O

(3) On Basic Setting, set Interface Type to Fluid Fluid. 

Under Sid

(5) Set Region List 1 to INT 5 A. 

(6) Under Side 2, set Domain to Stati

(7) Set Region Li

(8) On Interface Models, under Frame Change, set O
to None. 

(9) Under Pitch Change, set Option to

(10) Click Ok to create the interface. 

Dom in Interface 8 

 (1) Click Create a Domain Interfa on the main 

k. 

(4) e 1, set Domain to Stationary. 

onary. 

st 2 to INT 6 B. 

ption 

 Automatic. 

 
h) a

ce

toolbar. 

(2) Leave Name by default, then O

(3) On Basic Setting, set Interface Type to Fluid Fluid. 

Under Sid

(5) Set Region List 1 to INT 6 A. 

(6) Under Side 2, set Domain to Stati

(7) Set Region Li

(8) On Interface Models, under Frame Change, set O
to None. 

(9) Under Pitch Change, set Option to

(10) Click Ok to create the interface. 

Dom in Interface 9 

 (1) Click Create a Domain Interfa on the main 

k. 

(4) e 1, set Domain to Stationary. 

toolbar. 

(2) Leave Name by default, then O

(3) On Basic Setting, set Interface Type to Fluid Fluid. 

Under Sid

(5) Set Region List 1 to INT 7 A. 
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set Domain to Stationary. 

(8) face Models, under Frame Change, set Option 

 
i) a

(6) Under Side 2, 

(7) Set Region List 2 to INT 7 B. 

On Inter
to None. 

(9) Under Pitch Change, set Option to Automatic. 

(10) Click Ok to create the interface. 

Dom in Interface 10 

(1) Click Create a Domain Interface on the main 

(3) Setting, set Interface Type to Fluid Fluid. 

set Domain to Stationary. 

(8) face Models, under Frame Change, set Option 

 
E Setting Initial

1. Select Create rom the main 
menu b r

toolbar. 

(2) Leave Name by default, then Ok. 

On Basic 

(4) Under Side 1, set Domain to Stationary. 

(5) Set Region List 1 to INT 8 A. 

(6) Under Side 2, 

(7) Set Region List 2 to INT 8 B. 

On Inter
to None. 

(9) Under Pitch Change, set Option to Automatic. 

(10) Click Ok to create the interface. 

 Values 
 > File Objects > Global Initialisation f

ar, o  click Global Initialisation . 

2. Under Initial
Option  

3. Turn on  
Automatic. 

4. Click O

F Setting Solver Control 
1. Select Create  o  

Control

 Conditions, set Velocity Type to Cartesian. Other 
s are set to Automatic. 

 Turbulence Eddy Dissipation and leave Option set to

k to set the initialisation details. 

 > Flow Objects > Solver Control, r click Solver
 to o . 

2. Under Advection Scheme wind. 

3. Under Transient Scheme
Euler 

4. Under C e  Per Timestep to 3 

pen Solver Control

, leave Option set to Up

, set Option to Second Order Backward 

onv rgence Control, Set Max. Iter.
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5. Under C e MS. 

6. Set Res l

7. Click o

8. Click Ok to s er parameter. 

G Setting Outpu n

1. Select Crea

onv rgence Criteria, set Residual Type to R

idua  Target to 1e-8. 

n Conservation Target, set Conservation Target to 1e-8. 

et the solv

t Co trol 

te > Flow Objects > Output Control  from the main 
me

2. Click th

3. Click Add N nd then click Ok to accept the default name for 
the obj

4. Under T s

a) 
b) fault 

c) o 0.001 [s] 

5. Click O

H To start witho i
1. Create > Expert Objects > Expert Parameters from the main menu 

bar. 

2. Click I/

t Model and I/O, Turn on transient initialization 

4. 
I Wr

1. 

nu bar. 

e Transient Results tab. 

ew Item a
ect. 

ran ient Results 1:  

Set Option to Full. 

Leave File Compression Level to De

Turn on Time Interval, then set Time Interval t

k. 

ut in tial value for all domain 

O Control tab. 

3. Under Transien
override, and then set transient initialization to t. 

Click Ok to accept. 

iting the Solver (.def) File 

Click Write Solver (.def) File . 

utomatically. 

 set to Start Solver Manger. 

-

5. Click . 

J Ob
 

Definition File is created. 

2. File name CrossFlowFan.def is created a

3. Leave Operation

4. Leave Report Summary of Interface Connections and Quit CFX
Pre turned on. 

 Ok

6. Click Yes when asked if you want to save the CFX file. 

taining a Solution to this Transient Problem 
1. When CFX-Pre closes and then CFX-Solver Manager will start,

click on Start Run to start the run. 
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-Mom, V-
ss.K, and K-TurbKE. 

 result. 

II. Continuing the Transient Run 
Based on t u as 
follows. 

A Red

The residual plots for seven variables will appear: P-Mass, U
Mom, W-Mom, H-Energy, E-Di

2. When CFX-Solver finishes, the completion message will appear. 
Click Ok to acknowledge it. 

3. Click Post-Process Results to see the

he result obtained previously, more revolutions are req ired and are set 

efine the Simulation Type 

1. Select Create > Flow Objects > Simulation Type  from the main 
menu. 

2. Set Option to Transient. 

3. Under Time Total time to 
0.1

This w

e Steps, Set Option to Timestep, and Timesteps to 

e will be set automatically from the previous run. 

ormation. 

B Wr

.def) File

 Duration, Set Option to Total Time, and 
 [s]. 

ill provide 5 revolutions totally. 

4. Under Tim
3.33333e-5 [s] 

5. Under Initial Time, Set Option to Automatic. 

The initial tim

6. Click Ok to save the inf

iting the Solver (.def) File 

1. Click Write Solver ( . 

d. 

 

ted 
e name somewhat is suggested. 

ons and Quit CFX-

5. 
hen asked if you want to save the CFX file. 

s. 

 
ef. 

Definition File is create

2. Change File name to CrossFlowFan1.def

It is happened that solver cannot run due to definition file exis
already, so changing the fil

3. Leave Operation set to Start Solver Manger. 

4. Leave Report Summary of Interface Connecti
Pre turned on. 

Click Ok. 

6. Click Yes w

CFX-Solver Manager window appears after clicking Ye

C Obtaining the Solution to this Transient Problem
1. On Run Definition tab, leave Definition File to CrossFlowFan1.d
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2. 

4. he completion message will appear. 

s Results to see the result. 

Note: Sometimes there is a message popping up, it says, “the memory 
re is enough memory in the computer. The 

procedure to ignore this problem is as follows: 

t Memory Allocation Fact to 2 or more. 
 for CFX-Solver will be increased. 

Set Initial Values File to CrossFlowFan_001.res. which is obtained 
from the previous run. 

3. Click on Start Run to continue the ruin. 

When CFX-Solver finishes, t
Click Ok to complete it. 

5. Click Post-Proces

 

could not be read,” even the

1. Click on Solver tab 

2. Under Solver Memory, Se
Hence the memory shared
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